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Introduction

Introduction

Welcome to FileMaker Pro version 11.

FileMaker Pro is an application that allows you to store and organize information in a
database and to search and report out on that information. Sometimes FileMaker Pro is
referred to as a database solution because it fulfills both storage and reporting needs.

This course begins with the assumption that you have inherited a database. You need to
discover what information is stored in it, how that information is organized, and what
reports have been created for data entry and reporting. You will need to keep the
information up-to-date by creating, editing and deleting records and you will need to print
out some reports.

Course Objectives:

* Understand the terms records, fields, field types, commit a record, indexed, found
set, layout

* Understand FileMaker’s four modes Browse, Find, Layout, Print, and identify the
tasks that can be performed in each mode.

¢ Understand the different views of data: Form view, List view, Table view.

* Navigate through fields, records, layouts and modes.

* Enter, edit, duplicate and delete data from a database.

*  Perform simple and complex finds and sorts to locate and organize data as
appropriate for reporting. [Compare Quick Find with Find mode finds]

¢ Save and reuse finds.

* Create a simple layout.

* Print outareport, create a pdf, or save data to a spreadsheet.

* Distinguish between a “flat” database and a relational database.

The business of creating a new database is reserved for a later class. In the next class in the
suite, Reports, Layouts, and User Interface Design, we will explore the various ways
FileMaker allows us to report out on the information stored in our data base by exploring the
myriad ways of creating layouts. We will also create a small, simple database that will serve
as a way of exploring reporting and key database concepts. In the process, we will take a
closer look at file attributes and field characteristics. In the third course, we will look at
concepts of design and good practices when creating a multi-table database solution. We
will work toward an understanding of relational data and how multiple tables can be joined
to allow dynamic reporting capabilities.

In version 10 of FileMaker there was a significant change to the user interface. Almost since
FileMaker’s inception, a status bar occupied the left-hand side of the FileMaker interface
with the tools for each mode, buttons to switch between modes, and first a rolodex and then
book icon for moving through records, layouts, or report pages. This status area has been
moved to the top of the screen and new buttons appear that allow switching modes.

Version 11 is yet another evolutionary step: Features have been added to table view
allowing for the spreadsheet like creation of a database and data entry. Charts have been
added as a reporting feature. In Layout mode, the Object information palette has been
consolidated with other formatting commands to create a three-tabbed Inspector. FM 11
introduces Quick Finds which allow finds across fields. Portals have a new feature that
simplifies the creation of filtered portals. Folders can now be created to group and organize
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layouts. For a complete look at the new features in FileMaker Pro 11, go to Help ->
FileMaker Pro Help and on the opening page click on New features in FileMaker Pro 11.
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Module 1: Working with Existing Databases: An Overview of FileMaker 11

Module 1: Working with Existing Databases:
An Overview of FileMaker 11

This class assumes you have inherited a database and need to maintain it, that is
update and edit the data, run reports, and create new reports. How do you discover
what is in this database and find your way around?

Objectives of this module:
Learn how to open and explore an existing database

Become familiar with FileMaker Pro’s four modes for performing database tasks.
Introduce the terms records, fields, tables, and layouts

Explore database and data reporting concepts such as the relational nature of data and
aggregating and summarizing information.

What is a database? One author! defined databases as any body of information that
can be searched and sorted. This may be a very general description but these are
important characteristics to keep in mind as we learn to us the FileMaker
application and embark on the task of developing a database. The ability to search
and to sort are key criteria when we design our database tables and fields.

A database is a collection of related pieces of information (data) organized into
discrete records and fields. If you were to create a contact database with all the
information pertaining to our contact, each person would be considered a single
record. The separate pieces of information about that person, i.e., the person’s
last name, first name, and phone number would be stored in separate fields within
the record. These are sometimes referred to as attributes. Our entire address book
could in turn be stored as a single FileMaker table, each entry a separate record.

Visually, as shown below, a database can be represented by a table-like structure.
Each row in the table contains a record; each column is a field.

Field Name
\( StudentID j.astName FirstName Street
99850012 Rashmon Kira 55 Oak St.
99850153 Feingold John 12 Pine St.
99851542 Percy Reginald 6 Gold Rd.
99612542 Hwong Nan 2 Front St.
Single Record/v
With this is mind many ask, “Can I convert my Excel spreadsheet into
a FileMaker database?” The answer is yes. There are several ways

1John M. Osborne, the author of FileMaker books and training CDs.
[http://www.databasepros.com/about.html]
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Module 1: Working with Existing Databases: An Overview of FileMaker 11

to do this depending upon your spreadsheet and your desired results. You can drag
and drop the Excel icon onto the FM application icon in the Dock (Mac). You can
launch FileMaker and from the Quick Start screen choose Convert an Existing File:

800

FileMaker Quick Start

Create a New Database

Create a new file, then define fields,
add records, and enter data.

}} Create a New Database

\Conven an Existing File

Start from an Excel, Tab Delimited,

Comma Separated, Merge, or Bento file.

w Convert an Existing File...

Use a Starter Solution

Select a pre-designed template for
business, academic, or personal tasks.

E Use a Starter Solution.

Open a Database Q|

wRecent Files
old-InventoryExample DemoOne

Inventory_three .../ITPartners2010Presentat

EmployeeRecords-FM11Relational
officeteam

OfficeTeam
EmployeeRecords-FM11
EmployeeRecords

A Sketch

Inventory_three .../ITPartners2010Presentat
survey_test Converted .../temp - desktopcle

v Favorite Files

e e

Browse... ) Manage Favorites...

Video Tutorials

View instructional videos, plus get
access to other helpful resources.

Visit the Resource Center »

Hands-on Tutorial

Expand your skills with
step-by-step instructions.

Startnow »

FileMaker Forum

Ask questions and receive advice
from other FileMaker Pro users.

Go to the FileMaker Forum »

@Show this screen when FileMaker Pro opens

Close

You can specify File 2 Import Records after you have defined your table and fields
and then match (map) your spreadsheet fields to your database fields. This is one
of the easiest ways to create a database. In essence, if you are using an Excel
spreadsheet to maintain a list of one kind or another, you are using it like a
database. FileMaker is an elegant way of maintaining lists and allows you to depict
it in its relational nature. FileMaker also allows for the exporting of data into a

spreadsheet.
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Module 1: Working with Existing Databases: An Overview of FileMaker 11

FileMaker’s Modes
FileMaker has four modes of operation. In each mode, different tasks are
preformed. Each has a distinctive status area and toolbar. They are

Browse Mode:

e o EmployeeRecords (@)
10 30 = 24 =4 Q-
I@] —_—— Q Total (Unsorted) ‘_-_vj @ a gv WS - B Q
Records Show All New Record Delete Record Find Sort Manage
Edit Layout

N —— T = B

In Browse Mode you work with the data in your database: Enter data, view records,
create new records, delete records, sort records. You will do the majority of your
work in Browse mode. The results of a Find are displayed in Browse mode.

Layout Mode:

0

e o

Layouts

15
Total

|

New Layout / Report

EmployeeRecords

B (1) D00 ([OwEHuE) [+ (¢)

Layout Tools

Sk,
Manage

Revert Save Layout

s IR @)

TrT |13I

red

Table: Employee Records

Lt e )| B

IIIlllI|2IIII3III|4III|SIIIIGIII|7III|8IIllglllllollllllll:lllzl

-

Layout: Standard

In Layout Mode you design the way information will appear on the screen or
printed page using the many graphical tools to create reports and layouts.

Find:

EmployeeRecords

o o¥ G Q

New Request Delete Request Perform Find Cancel Find

®no
»B : | 2
[ f——" s

Find Requests

2],

—

Saved Finds

Layout: | Standard Matching Records:m Omit I Insert: | Operators zj

Zj 1 VlewAs:Eélﬁ

In Find Mode you can search for a record or group of records. This is your query.
The result of a search is called the “found set.” After the find is performed, you are

returned to Browse mode viewing that set of records.

Preview:

®no EmployeeRecords

I3 12 Jsemci—y S |

Pages Save as Excel Save as PDF

s

2 B

Print Page Setup

0

Layout: | Standard > | ViewAs:E = | H | I

In Preview mode you see reports and forms as they will print. Multicolumn reports
and label runs are two examples of reports that need to be viewed in preview mode

to see the final layout in preview mode.

Be aware that when resizing your FileMaker windows that toolbar icons appear and disappear
depending on the size of the window. Sometimes the tools you need have disappeared from lack of

space. Stretch and shrink the toolbar and observe!
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Module 1: Working with Existing Databases: An Overview of FileMaker 11

Exploring an existing database
Let’s begin by opening the class file called EmployeeRecords. Double clicking on
the icon will automatically launch the FileMaker application and open your database
file.

We are opening a file that resides on each of our individual computers. Back in the
workplace, many of us will click on an icon and it will be opening a database that
resides in a remote location, on a shared server. We may be one of many people
accessing that database at any one time. Clicking on the icon may launch a script
that automatically takes you to that database. Alternatively, you may go to File=>
Open > Remote and then navigate to the appropriate server and FileMaker file.

There is the option to open FileMaker and go to File = Open Recent. A drop-
down menu of the recently visited database files is displayed.

RESULTS: You will see a screen like the following. What is this?

e 06 EmployeeRecords —
2Bl 3 () 30 : o 5 24
& o/ Total (Sorted) = .} o= S, =
Records New Record Delete Record Find Sort
VN EL TR S rmmm— R ] = e (4] (e imous
™
!
LastName Title DateHired  Salary City :
Little Administrative Assistant 8/14/1994 $42,750 Newton i
Papas Administrative Assistant 2/4/1989 $39,350 Ashland :
Leggett Administrative Officer 9/1/1994 $55,000 Milton !
Gold Assistant Dean 3/1/1988  $49,500 Upton :
Dunn Assistant Professor 8/16/1993 $46,640 Boston !
Nartoli Computer Support 11/17/1978  $30,800 Danvers :
Garelli Consultant | 9/4/1993 $50,930 Fall River !
Sawyer Consultant Il 11/19/1989  $40,150 Revere :
Stein Consultant Il 9/7/1985 $42 240 Randolph "
Fayerweather Department Chair 9/17/1999 $53,240 Newtonville
Anjou Fiscal Officer 6/1/1991 $48,950 Gardner
Trainor Lab Tech 2/9/1994 $33,142 Somerville
Brill Lab Tech | 7/23/1988 $31,350 Boston
Lui Lab Tech | 6/15/1981 $32,876 Everett
Howard Lab Tech Il 7/1/1994 $40,370 Cambridge
Friendly Network Administrator 6/8/1983 $41,030 Brookline
Bison Professor 2/4/1997 $48,950 Framingham a
Colling Prafessnr A11/2002 %45 100 Jamaica y

100 o™ Browse

We are currently in BROWSE mode looking at a layout called “Salary.” Five fields
are displayed across the layout and records are displayed in a list-like form.

In the lower frame of the window, is the designation of the mode.
100 ‘J: Browse

. This designation is also a pop-up menu that allows you to
move between modes. Click on it and see.

Copyright © 2012 by MIT IS&T. 8



Module 1: Working with Existing Databases: An Overview of FileMaker 11

The other designations on this lower frame are, first, a designation of the scale of
the display. The second and third are buttons that look like mountain ranges allow
you to shrink or magnify this view. The fourth item is a button allowing you to
toggle the status bar on and off.

Browse mode can be distinguished by its status tool bar:

006 EmployeeRecords —
| ; 2 30 & oy 3 24
i A [P \_/ Total (Sorted) - P - =D =
Records New Record Delete Record Find  Sort
Layout: [Salary 'J View As: @ I Preview Edit Layout

How many records afe there in this database? What order are they in?

There are 30 records. The status area displays the count of total records. They are
currently sorted. When “Unsorted” is displayed, it signifies that the records are in
the order in which they were entered into the database with the newest entry last.

Notice the darkened vertical bar alongside a record in the list. This signifies that it is
the current record. The status area it tells you that this current record is 2.

How is data displayed and what is a layout?

FileMaker Pro displays data on layouts. We are currently looking at the Salary
layout which displays 5 fields in a list format. To switch layouts, go to the pull-down
menu in the status bar area:

008 Emplo

— 30
U Total (Unsorted)

Records

Here you will find a list of the layouts that have been
designed for use with this database. Simply choose a
layout from the menu and it will be displayed.

v Salary
Lasth Hiring Report

Emergency Contact Sample
Sample Report 1
Sample Report 2
Legge Sample Report 3
(i Sample Report 4

Garcig

Fletch

Howal  Labels
petrit Mail Merge Letter Sample

Garell  Personnel Info - Tabbed

Copyright © 2012 by MIT IS&T. 9



Module 1: Working with Existing Databases: An Overview of FileMaker 11

Switch to the Standard layout.

EmployeelD |9990000

LastName [Garcia

FirstName IAudrey

MITAddress [24-416

StreetAddress |4 Newmarket Street

Notice that in contrast to the

city [Medford
Salary layout, the Standard state |MA
layout displays only one zip [02141
record per screen. WorkPhone [3-2567

HomePhone (617 584 6826

Notice also there are many Email [agarcia@mit.edu
more fields displayed on this DateofBirth [3/12/1945 |
layout. To the left we see the DateHired [5/16/2008 |
field labels and to the right Department [Electrical Engineering
is the data, the field contents. Title [Secretary

salary [$30,800.00 |
salaryAvg [$41,671.68 |

Notes |

EmergencyContact |

RelationshipofContact |

Contactsphone I

salarytt [$1,250,150.40

Navigating through records

To move through the records in the database, you can use the book icon. Clicking on
5 theright hand page moves forward through the database
E%E‘] —o—— records. Clicking on the left-hand page moves backwards.
he counter increments as you move through the records.
This number is relative to the o orted or unsorted) that the records are in.

To move through records, you can also move the slider. This is especially handy if
you wish to move to the beginning or end of the file.

Finally, above the slider is the Current Record slot. You can click in the slot, type in a
number and press Enter or Return. FileMaker will go to that number record in the
current order.

If you prefer keystrokes,
CTRL + { moves to previous record
CTRL +| moves to next record.
The CTRL key is used with both the Mac and Window.

If you are using a mouse with a wheel (Windows), you can use it to scroll forward
and backwards through the record.

Copyright © 2012 by MIT IS&T. 10



Module 1: Working with Existing Databases: An Overview of FileMaker 11

These are just two examples of ways information can be viewed in FileMaker.
Layouts allow you to view some or all your fields. Here are some other examples:

Personnel Records

First Name [Wayne
LastName [Little

Phone [3-2654

Employee ID Number | 9990029
Department Electrical Engineering
Title |Administrative Assistant

Email [wittle@mit.edu

ID Number 9990029

Position Personal T N
Position | Administrative  pate of Hire | 8/14/1994
Salary | $42.750.00

Lawrence
Freida
Nora
Peter
Sarah
| Earl
David
el i
Anne
Christine
L. | Ted
Audrey
Craig
Denise

Bonnie
Chris

.| Herb
Bill
Wayne
Bert
Andrea

Anjou 3-2612
Baumgartner 3-2603
Bison 3-2588
Brill 3-2609
Chu 3-2615
Collins 3-2600
Colt 3-2627
Correia 3-2633
Darden 3-2642
Dunn 3-2594
Edgewater 3-2624
Fayerweather  3-2618
Fletcher 3-2570
Friel 3-2597
Friendly 3-2645
Garcia 3-2567
Garelli 3-2585
Gold 3-2501
Howard 3-2579
Jacobs 3-2651
Landry 3-2606
Leggett 3-2573
Little 3-2654
Lui 3-2576
Nartoli 3-2648

janjou@mit.edu
ghaumgartner@mit.edu
chison@mit.edu
ibrill@mit.edu
Ichu@mit.edu
feollins@mit.edu
neolt@mit.edu
peorreia@mit.edu
sdarden@mit.edu
edunn@mit.edu
medgewater@mit.edu
Ifayerweather@mit.edu
afletcher@mit.edu
cfriel@mit.edu
tfriendly@mit.edu
agarcia@mit.edu
cgarelli@mit.edu
dgold@mit.edu
bhoward @mit.edu
cjacobs@mit.edu
hlandry@mit.edu
bleggett@mit.edu
wlittle@mit.edu
blui@mit.edu
anartoli@mit.edu

Above is a sampling of different ways that FileMaker layouts can be designed to
display information: (going clockwise from the upper left) as a mail merge letter, as
a layout with information grouped into different tab panels, as a list, as labels.

Task: Peruse the different layouts in the sample file. Search out: Which layouts
include DateHired, BirthDate, work phone....Compare the tabbed layout where you
see one record per screen with that of a list where you see multiple records.

Copyright © 2012 by MIT IS&T.
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Module 1: Working with Existing Databases: An Overview of FileMaker 11

Viewing information as forms, lists, tables
Layouts can be viewed in three different ways: as a form, as a list, as a table.

When creating a new layout, there is a default view associated with it.

You can switch between Form View, List View, and Table View by using the
buttons in the Layout bar.

| ViewAs:[=§@] |

Form List Table
* Form View displays the layout with one record at a time. (Standard, Mail
Merge are examples)

* List View displays layout as a list, displaying records one after the other.

* Table View removes all the embellishments and displaying fields and
records as if they were in a grid or spreadsheet.

Manage 2> Database
There may be even more fields than what we see in the Standard Layout. To
determine how many fields are defined in the database, goto File = Manage—>
Database.. The keystroke is Ctrl-Shift+D on Windows or Cmd-Shift+D on the Mac.
(Think: Control —-Capital D.)

RESULT: The Manage Database dialog box opens.

I Tables | Fields = Relationships !

Table: | Employee Records ¥ 25 fields View by: | custom order 2

Field Name lType l 0&/ Comments (Click to toggle) Ia

4 EmployeelD Text Indexed, o-enter Serial, Can't Modify Auto, Unique

4 LastName Text Indexed\ :

4 FirstName Text Indexed

4+ MITAddress Text

¢ StreetAddress Text This tells the number of fields
¢ City Text Indexed il’l the table.

4 State Text

¢ Zip Text Indexed r T
4+ WorkPhone Text

4 HomePhone Text

4+ Email Text

¢ DateofBirth Date

4 DateHired Date Indexed A

¢ Department Text v
Field Name: || Type: | Text % ] Options

Comment:

( Create ) Change Duplicate Delete

| Print Cancel ) ( OK

]

Be sure the Fields tab is selected. Here you see a list of the fields that have been
defined for this database table.

Copyright © 2012 by MIT IS&T. 12



Module 1: Working with Existing Databases: An Overview of FileMaker 11

Additional fields can be defined for the database here. Fields are named, assigned a
type (text, number, date, calculation, etc.) and also given options. Click OK to exit this
dialog box.

“I can’t visit this dialog box from my database back in my office. Why?” Viewing this
information is granted or prohibited by access privileges that have been set up. In this class
we will be viewing sample databases as if we had created them, thereby having
Administrator privileges which allow viewing, editing and deleting all.

Leveraging Table View
FileMaker 11 added some new features to table view. Within this spreadsheet-like
view of the database, you have gained capabilities found in the Manage Database

area.
CI—=——
. Records
* On the left edge after the last record, there is a plus
sign. This can be used to add a new record. —
EmployeelD Le
9990200 Fayerw
9990018 |Papas
| |o990019 Edgew
| |o990020 Colt
9990021 [Trainon
| |o990022 Correic
| |o990023 Stein
9990024 |sawye
| |e990025 Darder
9990026 |Friend
9990027 |Nartoli
| |o990028 Jacobs
9990029 |Little
| »[|9990042
H
100 und B Browse €
* On the top margin to the far right there is a plus sign which allows

you to define a new field in the database.
[By default, it will be a text field.]

Modify... ‘

laryAvg | Salaryttl [+
671.68
671.68
671.68
,671.68
671.68
,671.68
,671.68

LR R e e e RER RN
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Module 1: Working with Existing Databases: An Overview of FileMaker 11

¢ (Clicking at the top of the column, in the field name, exposes a downward
arrow. Click on this
arrow to

bring
up a menu of =
el =Yg Sort Ascending
possibilities. 50 Sort Descending
50 Sort By Value List >
zg Field Type ) v Text
I E— Field Options... Number
| — . i Date
) 50 Add Leading Group by new field Time
To the right, you see an example of s Timestamp
; 50,  Leading Subtotals > Container
how to change the field type from s — ,
K K ) o — Add Trailing Group by new field
inside table view. o Summary...
- I Trailing Subtotals S
‘ Set Column Width...
Hide Field
Delete Field...

Modify Table View...
Reset Table View...

Copyright © 2012 by MIT IS&T. 14



Module 1: Working with Existing Databases: An Overview of FileMaker 11

Switching Modes
There are a variety of ways to move between FileMaker modes. There are buttons, menu
selections, and keystrokes.

Returning to the FileMaker application window, pull down the View menu and notice the list
of modes. Alongside each mode is the key-
stroke designation for switching to that mode.

VU8 Insert Format Records

To the left are the Macintosh keystrokes. On

Windows, use the Control key plus the letter v Browse Mode 3B
designation. Find Mode BF
Layout Mode #BL

In the lower left-hand corner of the Preview Mode
application window is pop-up menu that i . |
allows you to navigate from one mode to another:

| v Browse %
Find

Layout et
Preview

100 oo B Browse

BROWSE mode
Returning to the status bar in Browse mode, notice there are buttons to perform tasks (New
Record, Delete Record, and Show All when a found set is in effect) and to switch to other
modes (Find, Edit Layout, Preview).

®00 _EmployeeRecords_ (@]
17 7\ 30 & > o
A —— \_/ Total (Unsorted) = ,Sr_:r'? ﬁ k&, %i} »
b Records Show Al New Record Delete Record Find  Sort L
| e <) | vewss (= W) | () Caiimen )t

While in Browse mode, there is a Records menu, comprised of tasks that can be performed

in Browse mode: Scripts  Window Help_
¢ New Record 3#EN
> Click on the New Record. Duplicate Record ®D

‘ Delete Record... 3#E

RESULTS: A new blank record appears awaiting input A few
fields already have information in them. Why? ‘ GoKolRecold >

Delete All Records... I

Refresh Window 1r 38R

In some fields, data is automatically generated. For example, S omied Snly
EmployeelD is set to “Auto-enter Serial, Can’t Modify.” You can Omit Record ®T
see the specification of this option by returning to File> Omit Multjplesos DT

Manage - Database ... The two other fields, Salary Total and el ®
Salary Average, are calculation fields. The number you are sort Records s

seeing in the result of those calculations.

These are just a few of the things you will see as you peruse
your database in Browse mode. If you are still in the “create
new record” process, click outside the fields, that is, in a white
space.
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Module 1: Working with Existing Databases: An Overview of FileMaker 11

Unlike Word, Excel and other programs where you save your work frequently throughout a
session, FileMaker saves your work automatically. Therefore it is important to be aware of
what you are doing, especially when deleting or making large changes to your file. A backup
copy of a file can be created.

Copyright © 2012 by MIT IS&T. 16



Module 1: Working with Existing Databases: An Overview of FileMaker 11

Find Mode
Find mode allows you to search for records in the database. You can search based on a
single criterion or on multiple criteria. Since FileMaker 10, finds are saved
and may be reused.

.\
In Browse mode, there is downward pointing triangle alongside the Find Find
magnifying glass icon.
Clicking the triangle (Windows) or click and holding (the Mac) A, g
the mouse brings up a menu of recent finds and the tasks for find _Sort
saving finds, shown to the right. Up to 10 recent finds are saved. |+ Create New Find s

. . i . . Modify Last Find
There are also options for creating and modifying previous finds.

Save Current Find...
Edit Saved Finds...

<50000
Framingham

Clear All Recent Finds

In Find mode, they are listed under the Saved =,
Finds icon. Saved Finds

Clicking on the magnifying glass icon takes you into Find mode. Here you will see a
different toolbar, with options for creating finds:

e 06 _EmployeeRecords_ (=)
Y ) P \‘I:S \_Q (el
— Total Q Q =

Find Requests New Request Delete Request Perform Find Cancel Find Saved Finds

Layout: | Standard z\ | View As: E = ‘ = Matching Records: m Omit Insert: | Operators zl

An empty record is displayed with the field boundary boxes and once you click in a
field, small magnifying glasses appear to cue you that you are in Find and not
Browse mode:

Employeeld Simply, if you enter information
:“‘:a'“* , into a field and click Perform
irstName | : . . . -
MITAddress | i Find, FileMaker will find all
StreetAddress records whose field matches

aty ‘ that, returns to Browse mode
s":': and displays only the matching
records, known as the found set. The Browse toolbar displays the number of
records comprising the found set and a pie chart displaying the ratio of found
records to the entirety. Each of the layouts now displays only this found set.
Clicking on the book icon, you can march through the records in the found set.
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Module 1: Working with Existing Databases: An Overview of FileMaker 11

en0e6 _EmployeeRecords

1 4/30 = ] 5
& & Found (Unsorted) B F=
Records Show All New Re

Layout: [ Standard v | VlewAs:l Preview

This pie chart is also a button. Click on it and FileMaker displays the opposite of the
found set, the omitted records. Click again and you return to the found set.

To see all records in the database again, click on the Show All button.

Layout Mode
A layout provides a means for displaying or reporting on the information in the
database. It can be a screen that allows data to be input into the database. A layout
can be as simple as name badge, or as complex as a report which organizes and
displays records with totals, subtotals and other calculations. It can be a mail merge
letter.

» Switch to Layout mode and observe the different tools for creating and
modifying layouts. Designing a layout is a lot like working with a graphics

program.
006 T _EmployeeRecords_l O
Pl 8%, @ BhEloECHEmEFee
Layouts New Layout / Report Layout Tools

Layout: "Standard v &Y  Table: Employee Records = O | Al evert

Exit Layout

| Helvetica ~)(48_~] N I B M une:[ 10t~ | R | Fill: h

8 E
E||||1III|I|||I||||||||3|||[|I||4||||IIIISI|||||||6|I||||||7|I|||I||b|||||I||J|||||I|1?|||||m

» In Layout mode, use the pull-down menu to move through the different
layouts. Observe differences (headers, footers, report summary parts, tab
panels). Alternatively, you can click on the book icon to move through the
different layouts.

» Click on Exit Layout button and you return to Browse mode.

Preview Mode
Preview mode allows you to see what a layout will look like when it is printed.

Notice the buttons in the toolbar. Here you can quickly create a spreadsheet or a
PDF of the layout you are viewing.

CEGNG) _EmployeeRecords_ O
i ! - J h
o h_u Total - =
Pages Save as Excel Save as PDF Print Page Setup
Layout: | Salary v | View As: | m= %I B | I Exit Preview

There are some report features that are not shown in Browse mode, but can be seen in
Preview. For example, layouts such as labels are created in Form view, showing a single
record at a time in Browse mode, while in Preview, the entire label run is displayed, sheet by
sheet.

» View the label layout first in Browse and then in Preview.
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Module 1: Working with Existing Databases: An Overview of FileMaker 11

Another example is a list that is multiple columns. Only a single column displays in Browse,
but the multiple columns appear in Preview.

» View Sample Report 2 in Browse and Preview.

Exercise 1 — Determine the mode for each of the tasks
Specify the proper mode for the task in the left column:

Browse Find Layout Preview

Function Mode

1. Edit data

2. Create a new report

3. See how a layout will print

4, Create a new record

5. Search for a subset of data

6. The results of a find are displayed here

7. Create a PDF of the layout

8. Sort the database

Exercise 2 — Review Navigation Techniques
1. Ifnotalready open, open the Employee Records file in the class folder. Go to the
Standard layout and navigate to record number 21. Whose record is it?

2. Find Earl Dunn’s record, What is Earl’s record number?

3. Name at least one layout that has all of the following fields:
First Name
Last Name
Date of Birth
Date Hired

4. Where do you go to see a spreadsheet-like arrangement of the data in your database?
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Module 2: Working in Find Mode

In this module, we will

Locate records that match a single criterion

Locate records that match more than one criterion
Locate records that match at least one of two criteria
Omit records from the found set

Perform a find and replace

Reuse finds/Create and modify Saved finds

Explore FileMaker’s new Quick Find feature

Searching is one of the most important tasks in database use. Today we have
advanced search engines to bring us information from the World Wide Web in
answer to our everyday needs and curiosities. To create meaningful reports in
FileMaker, selecting only the appropriate information from the database is crucial.
With a few basic skills, it is easy to search a FileMaker database quickly and
efficiently.

When you perform a find, FileMaker searches through all the records in a table.
Those records that match the criteria become the found set. Thereafter, you are
only working with those records until such time as another find is performed or
until you request to see all records.

FileMaker Pro performs what is known as a “begins with” search, that is, it seeks to
match the string beginning with the start of a word. To search for strings within
words, wild cards can be used.

Quick Find
Before switching to Find Mode, be aware there are two
quick finds that you can perform in Browse mode.

0

Q-

First, FileMaker 11 implemented a new search
capability called Quick Find. Using the Quick Find search slot on the Browse
toolbar, Quick Find will search across all fields in a layout. This search tool may not
be evident because your Browse toolbar area may not be wide enough. Stretch the
window wider to reveal this search box. To execute a Quick Find search, the
capability must be enabled for the layout and the fields on the layout. By default,
layouts are enabled for quick find and all fields that are supported for quick find are
set to be included in the search. Type the search string into the box and press
Enter or Return. Your find request returns a fount set. The only operator supported
by Quick Find is the match phrase operator, the double quotation marks. One of the
niceties of Quick Find is that you can include merge fields in your find. Like in other
searches, the downward pointing arrow implies that searches are saved and can be
revisited.
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Module 2: Working in Find Mode

Secondly, a quick find/match [introduced in FM 8.5] on a specific field can be

performed via the right-mouse click (cltr-click on the Mac) and the shortcut menu.

In the example below, we are looking at the Salary layout. If we wanted to find all

employees who lived in Everett, we could select Everett in the city filed, right click

(Windows) or ctrl -click (Mac) and from the shortcut menu, choose Find Matching

Records.
LastName Title DateHired Salary City
Fletcher Professor 6/14/1978 $49,060 Winchester
Leggett Administrative Officer 9/1/1994 $55,000 Milton
i Hab Tech i BiTB981 837 876 i [Everett
) FileMaker Pro Help
Howard Lab Tech Il 7/1/1994 $40,370 Cambridge
Petricelli Technician 3/17/2009 $35,860 Boston
Garelli Consultant | 9/4/1993 $50,930 Fall River
Bison Professor 2/4/1997 $48,950 Framinghan
Gold Assistant D 3/1/1988 $49,500 Upton Ront L
| n n al A .

0 ssistant Deal p Size >
Dunn Assistant Professor 8/16/1993 $46,640 Boston Style »
Friel Secretary 5/27/2006  $33,275 Cambridgge. ~ Text Color >
Collins Professor 6/1/2002 $45,100 Jamaica Insert »

i 9/4/1994 34,54 Cambridge .
Baumgartner Program Coordinator 4] $34,540 it} Sort Ascending
Landry Professor 6/1/2003 $47,190 Watertown Sort Descending
Brill Lab Tech | 7/23/1988  $31,350 Boston Sort By Value List >
Anjou Fiscal Officer 6/1/1991 $48,950 Gardner Find Matching Records
Chu Secretary 7/18/1996  $30,140 Arlington Constrain Found Set

p Extend Found Set

Fayerweather Department Chair 9/17/1999 $53,240 Newtonville
00/ ud = Browse e s 1 Export Field Contents... |

Your find request returns two records for people who live in Everett. This is the

found set.

The status bar displays the number of found
records out of the total records in the
database. The light green area of the pie chart

1 P Found
o—— =@

Found (Unsorted)

Records

displays the found set as a portion of the total
records.

This pie chart was new to FileMaker 10. It is also a button. Clicking on it displays
the reverse of the found set. Clicking a second time returns you to the found set.

Clicking on the book icon now, in all of the layouts, moves you through only those

records in the found set.

Find Mode

Switching into Find mode, we can perform more complex searches using operators

and multiple criteria. There are several ways to get into Find mode:

* From the popup menuy, select Find.

¢ (Go to View 2 Find Mode

¢ In the Status toolbar, click the Find tool.
*  PressCtrl/38 +F

Copyright © 2012 by MIT IS&T.
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Module 2: Working in Find Mode

As mentioned in our overview, when you go into Find mode, a blank record is
displayed and magnifying glasses appear in the fields. 2

In the appropriate field, enter the text, number, or date you want to find. This is
referred to as a find request.

Click Perform Find (or press Enter or Return). Or if you changed your mind, click
Cancel Find.

RESULTS: Perform Find places you in Browse mode K% k‘g
displaying the results of the Find. The find sequence is added  |[Perform Find Cancel Find

to the Recent Find list.

Cancel Find returns you to Browse mode with no change to the previous status. That
is, if a found set were currently in effect, it still is. (This was not the case with previous
versions of FileMaker where each time you went into Find mode it would cancel out
the previous found set.)

Try it >
1. Find all people who have the job title of Secretary.
2. Find the individual whose last name is Dunn.
3. Find all people who live in Somerville.
4. Find all Professors.

The default search performed is a full text “begins with” search. This means that it
will search for words beginning with the string you specify. For example, if you type
Prof into the title field, any titles whose words begin with Prof will be returned.

This would return “Professor”, “Assistant Professor” as well as “Professional
Wrestler” if it were in the file. Just as an example, it would not return a record that
had “FileMakerPro” in the field, because the string is embedded in the text. If you
wanted to find any occurrence of the string p r o in the job title field, you could use

the wild card operator and supply the string *pro*.

Z FileMaker 11 sees the advent of little green and yellow magnifying glasses in fields in
Layout mode. This has to do with Quick Find mentioned above. The green magnifying glass
indicates the field is enabled for Quick Find. The yellow glass indicates that the field is
searchable but may take longer than fields with the green glass. This may be because it is a
related field, a calculation field or one that cannot be indexed. Later you will learn that you
can turn on or off the ability to search fields with Quick Find.
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Drawing Values from the Index View Index
FileMaker automatically indexes the valuesin a
) B ) i Computer Support

field and we can draw from this list. For example, if Consultant |

we weren’t sure about a specific job title that we Denartment Chair .

wanted to search on, selecting the field, go to {isl:aTl Ozﬁcer |
a ec

Insert = From Index... A dialog box like the one Lab Tech 1 :

on the right opens. You can select from the list and ;f:;cffkh:dmmistmm :

choose Paste. Professor .
Program Coordinator

i L. Secretary !
The check box labeled Show individual words does Tech Writer "
just that: it lists the occurrence of every word e e ofar 3

found in that field.

"I Show individual words

Click in the check box and observe the results. Click Re-sort values based on: [ > \

again to return to the original list. B
(_ Cancel )

Using Find with Search Operators
What if you wish to find a range of values, for example all people whose last names
begin with D through M, or all hired between 2/10/94 and 2/10/2000? In Find
mode, click on the Insert: Operators pull-down menu to display a list of operators
that can be used in your search request. You can either type the characters into the
find request or select them from the

= match whole word (or match empty)

ment. == match entire field
In the example above, if you wished to L 1 find duplicate values
just retrieve individuals with the title [
Professor and not Assistant Professor < less than
you would prefix Professor with == < less than or equal

. > greater than
(the double equal sign).

= greater than or equal
... range

// today’s date

? invalid date or time

Note: There is no space between the
values and the three dots for range.

To search for an empty field, use the @ any one character
double equal sign and nothing else in # any one digit
the request field. * zero or more characters
\ escape next character
To determine what your last find was, " match phrase (from word start)
in Browse mOde, g0 to Records 9 *" match phrase (from anywhere)

Modify Last Find. This automatically
takes you into Find mode and displays
the last find request you performed.

~ relaxed search (Japanese only)
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Exercise 3: Review of Find Techniques
For this exercise, go to the file Find_EmployeeRecords. Open the file and navigate to
the Salary Layout.

1. Find all people who are professors

2. Find all people who live in Boston

3. Find all people who earn exactly $47,190

4. Find all people hired after March 1, 2000

5. Are there any records where the hire date is missing?
6. Find all people who earn between $33,000 and $42,000

7. Find all people whose last names begin with A to M and then
sort the found set.

8. Show all records. What is the sort order now?

Refining Your Requests With AND, OR, OMIT

The AND request

You can refine you current Find request to match multiple criteria in separate fields. For
example, you may want to find all professors who began working after March 1, 2000. This
is known as an AND search. An AND search specifies multiple criteria in single request.

1. Click Find in the status toolbar.

RESULT: This places you in find mode, viewing the field boundary boxes with the
magnifying glasses.

2. Enter Professor into the title field and the >3/1/00 in the date hired field.
3. Click Perform Find or press Enter/Return.

RESULT: FileMaker will display all records matching the two criteria. If no records
match, a dialog box appears giving you the choice to either Cancel or Modify the
Find.

The OR Request

At times you may want to find records that match multiple criteria in the same field or
multiple fields. For example you want to know all people who live in either Boston or
Jamaica Plain. This is referred to as an OR request and is created by submitting multiple
requests in Find mode.

1. In Find mode, type the first criterion into the appropriate field. Here b
we will enter Boston in the City field. Q
2. Click on the New Request button. oo
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Module 2: Working in Find Mode

RESULT: This opens up another line in the form for entering the second criteria. If the
layout is a form type,[one record per screen], it will open up another screen with a blank
form. Observe the screen and the status bar:

SNGNG)

Layout: | Salary

2 2
E — @ Total

Find Requests

v| | Viewas:| == %@

_EmployeeRecords_

P #

F & & @ @

Perform Find Cancel Find

@] Q
New Request Delete Request

Matching Records: m Omit

Insert: | Operators '\

o
Q]

Saved Finds

LastName

Title

DateHired

Salary

City

Boston

A line is added where a second city can be specified. The book icon and the
record counter slot in Find mode refer to Find Requests. It currently we are on
the second request.

3. Enter the second criteria in the space created.
In our case we will enter Jamaica Plain.

You can add a third, and fourth requests, etc. as appropriate for the Find you
need to perform.

To move between requests, either click in that area of the screen or use the
book icon to move. The Delete Request button is used to remove requests.

4. When ready, click either Perform Find or Enter/Return.

RESULT: All records of people living in either Boston or Jamaica Plain are
displayed in Browse mode.

Exclude Records from the Found Set

Often times we know what we are NOT looking for. For example, maybe we want to
do a mailing to everyone except those that live in Cambridge. In a case like this we
use the Omit button in Find mode (of course you can find all that live in Cambridge

h he little pie chart for th ite of
and then press the little pie chart for the opposite o Matching Records: (include m

OMIT:

the found set). By default, Include is in effect. With
your request selected, click on Omit.

For a Find with multiple criteria, move to the appropriate request and click Omit.

Once you have a found set and you wish to remove a record

from it, in Browse mode, select the record, go to Records
menu —> Omit Record.

Omit Multiple

Starting from the current record,

omit 1 records.

You can also omit multiple records, starting at the current (Cancel) (Eomits)
record. See Records = Omit Multiple.
RESULT: The above dialog box appears allowing you to specify the number of
consecutive records you wish to exclude.
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Reusing Finds

FileMaker 10 introduced the ability to save finds. Your 10 most recent finds are
automatically saved and can be reused from the pull-down menu.

In Browse mode, there is a triangle

alongside the Find icon leading to a There is a similar menu in Find
pull-down menu with the most recent mode with the Saved Find icon:
Finds: -
Q = E o
SO B  Save Current Find...
Edit Layout_|. Edit Saved Finds... &
Create New Find — 2
Modify Last Find ir
a
Save Current Find... _1 ecent Fir &
Edit Saved Finds... boston; OR jamaica plain |,
M...Z i
o OMIT cambridge it
- *[+/1978 v
boston; OR jamaica plain j/j/2008 :
M...Z 22007 ]
OMIT cambridge 33000...42000 !
*[*/1978 =
“ 12008 >3/1/2000
“ 12007 ==professor
33000...42000
_ - Clear All Recent Finds
>3/1/2000
==professor

Clear All Recent Finds

#

To re-execute a find, simply select it from the list.
RESULTS: In Browse mode, it performs the find and displays the found set.

In Find mode, it sets up the request(s). You must now click on the
Perform Find button or click Return/Enter.

Finds that you will use repeatedly, can be saved, assigned a name, even edited. This

simplifies some of the need to script finds for later use.

Copyright © 2012 by MIT IS&T.
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To save your last find request:
1. In Windows, click the down arrow on the Find button and choose Save Current
Find. On the Mac, click and hold the Find button and then choose Save Current
Find.

RESULT: ThefOHOWing Specify Options for the Saved Find
dialog box opens, allowing

you to rename the Find Provide a name that represents this find request criteria. You can also
modify the criteria that will be saved.

request if you so desire. The
Advanced button takes you Name: M..Z
to a series of dialog boxes
where you can delete, (" Advanced... ) (Cancel ) € Save )
duplicate or edit your find

request.
2. Assign it a new name if you so desire. Click Save.

RESULT: The Find request will be added to your Saved Finds list.

Searching Merge Fields
When we study the creation of layouts in the next FileMaker class, we will see that
Merge fields, like those found in Word Mail Merge documents, are different than
ordinary fields. Merge fields allow you to combine field data and text in documents.
Prior to FileMaker 11, you could not search on merge fields in a layout, that is, if you
wanted to search for Professor Earl Dunn in your label run, you would have to do
the search in a layout where you could search on either his first or last names. Now
with the introduction of Quick Find in FileMaker 11, you can search on the contents
of merge fields.

* Tryit! Go tothe Mail Merge document and in Browse mode used the Quick
Find search slot to search for any employees named Garcia.

Find and Replace
[t is possible to edit multiple records, changing the entire contents of a field. For
example, a job title or a department may need to be changed globally throughout the
database records.

1. Perform your find request to arrive at the Found set.

2. Click in the field to be replaced.

3. Type in the field, replacing the entire contents of the field.
4. Go to Records = Replace Field Contents...

RESULT: The Replace Field Contents dialog box opens reflecting the
change, awaiting your confirmation of the change.
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EmployeeId 9990013

LastName ‘Landry

FirstName Herb

MITAddress E14-277

Replace Field Contents

treetAddress 82 Chestnut Road
city )
state IMA

Permanently replace the contents of the field
“Department” in the 5 records of the current found set?

zip 02182

WorkPhone i3-2606

HomePhone 617 584 6805

Email hlandry@mit.edu
DateofBirth 7
DateHired 6/1/

@ Replace with: “Media Arts and Science”

") Replace with serial numbers:

Department |Media Arts and Science

Title
salary

salaryavg |$43,582.00

=

Notes

hencyContact

7 Replace with calculated result: ( Specify... )

hipofContact

bntactsphone

( Replace ) { Cancel )

Salaryttl |$217,910.00

e—

Observe: Here we searched for all occurrences of E14 in the address

field and found 5 records. We change the field contents of the

Department field and before committing the record, go to Records >

Replace Field Contents.

Pause in this dialog box to observe that here too you can add serial
numbers to records (Try it!) or use a calculation in the replacement of

the field contents.

5. Click on Replace.

RESULTS: This will change the department name to Media Arts and

Sciences for all records in the found set.

> Tryit!

In Browse mode, there is also a Find/Replace. This is different than Find mode.
Find/Replace in Browse mode searches for pieces of text across fields and records

whereas Find mode searches for Records based on field contents. In Browse mode,
going to Edit=> Find/Replace opens the following dialog box:

Find what: |

Find/Replace

Replace with:

Direction: = Forward

Match case

Match whole words only

( Find Next )
(_Replace & Find
T] ( Replace
Search across: Search within: ( Replace All )
@ All records @ All fields
") Current record T) Current field | Close

Observe the check boxes and radio buttons that allow you to restrict the

Find/Replace action.
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This can be used in conjunction with a find, performing an edit upon all records in a
found set.

Exercise 4 - Review of AND and OR Searches

If not already open, open the Find_EmployeeRecord file and Number of
navigate to the Salary layout. Found Records

1. Find people who are Lab Techs or Consultants

2. Find all who are Professors or who live in Cambridge

3. Find people who live in Boston AND make over $45,000

4. Find people who earn less that $40,000 and started working at
MIT before January 1, 1996.

5. Find all secretaries except those living in Cambridge.

6. Find all people who earn more that $45,000, excluding
professors.

7. Revisit the find in #3 and change it to all that make over
$35,000. (Use the Recent Find list).

8. Find all Professors, including Emeritus and Assistant but
excluding Visiting.
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Module 3: Working in Browse Mode

In Browse mode we will

Navigate through the fields of a record
Enter and edit data

Delete and replace data

Create a new record/Delete a record
Sort records

Export data

Create a copy of the database

Moving within a Record

>

>

>

Click in a field to make that field active.
Pressing the TAB key repeatedly moves you field by field through the layout.
Shift-Tab, moves you backwards through the fields.

Note: Using the Return/Enter key does not move you from the current field to the
next. Instead, it places a carriage return in the field. To remove it backspace over it.
Once you click outside the field boundary box, the stretched appearance of the field
will disappear.

Go to the Standard layout and tab through all the fields. backspace over it.
Notice some fields are skipped. These are fields where data is not entered by you
but instead is the result of a calculation or a summarization.

Tab to the Salary field.

Observe that the number is displayed without the currency formatting. This is
because the dollar sign and comma separator are formatting that is applied to the
data and is not the data itself.

Click outside the field, and you see the number with the formatting applied.

Entering and Editing Data
1. Gotoarecord, locate your cursor in the appropriate field, and type.
2.  When complete, click outside the field and you have committed the record. The
database has been updated to reflect this change.

When selecting data in a field, the usual selection techniques are in effect:

dragging across selects data,
double clicking in a word selects just the word,
triple clicking selects a paragraph.

Committing a record
FileMaker automatically updates the database as you work. Go to the File menu and notice
there is no SAVE command but there is a Save A Copy As.
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When creating or updating a record, and you click outside of all fields or press enter, you do
what is called commit the record. This tells FileMaker that you are committing the changes
you just made and the database is updated accordingly

Revert Record
Prior to committing a record, you can revert to the record’s original contents.

Example:

1. Go to the Salary layout and choose the record for Edgewater. Change his job title to
Administrative Assistant. Tab to the salary field and change his salary.

2. Without clicking outside the record, go to Records = Revert Record.

RESULT: A dialog box appears asking if you want to “Revert all changes since it was last
entered?”

Click Revert and observe the fields returned to their original value.

4. Try this again with another record, but change the first field, click outside the record,
change another field and then go to Records > Revert Record. *

Delete Data and Replace Existing Data in a Field
To clear a field, select the field contents and press Backspace/Delete.

To remove selected text or the character to the left of the cursor, press Backspace/Delete.
To remove text to the right of the cursor, press the Delete key (in the keypad area, fn+delete
on Mac laptop keyboards).

Create a New Record .
*  Press the New Record button. e Q|
*  Go to Records = New Record New Record

*  Oruse the keystroke Ctr/38 + N.)
Example: Go to the Standard layout in Browse mode and press New Record

RESULTS: In this FORM layout, a blank screen appears; in the case of a LIST layout, as in the
Salary layout, a blank record area appears ready for you to input data into the spaces for the
fields.

This new record will be placed at the end of the database and will be permanently assigned to
that position in the default/unsorted record order.

OBSERVE: The EmployeelD field already has information in it. Why? Try to change the
number in the field. What happens?

This is the result of creating a field with the options “Auto-Enter, Serial, Can’t Modify, Unique”
to it. Go to File > Manage 2 Database and click on the Fields tab if it is not already selected.
Notice the assignment of this option.

Delete a Record
To permanently delete a record from the database: ‘:'3

Delete Record

e

1. Navigate to the record in the database you wish to delete.
2. Press Delete Record button in the toolbar. (Or go to
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Records = Delete Record.)

RESULT: You will get a confirmation message asking if you are sure you wish to
“Permanently delete this ENTIRE record.”

BEWARE: Using the menu, Delete Record and Delete All Records are dangerously close to
each other.
When a found set is in effect, this will read Delete Found Records.

Duplicate Previous Record
The Duplicate Record command saves having to re-keying repeated data.

1. Navigate to the record you wish to duplicate.
2. Go to Records = Duplicate Record.

RESULT: FileMaker creates a duplicate of the current record, placing it after the last
record in the file.

You can now edit that record as appropriate. Notice in our case, a new EmployeelD is
assigned, following in the sequence.

Duplicate Select Fields from Previous Record
If a new record contains some, but not all, fields of another record, with a simple
keystroke, you can enter that repeated information. Here’s how:

1. Navigate to the record whose field(s) you wish to duplicate. Click IN the
record. Clicking in one of the fields of the record signifies that you have
“visited” the record.

2. Navigate to the record where you wish to duplicate this information. In our
case we will create a new record: press the New Record button.

3. Clickin the field where you wish to repeat the information from the other
record and either go to Insert = From Last Visited Record or use the
keystroke Ctrl/38 + ‘ (single quote mark).

RESULT: The value of the field from the “visited” record is duplicated in the field of the
current record.

You can repeat the command/keystroke to duplicate other fields from that record.

Try it: Let’s say that another employee with the same job title and salary as Connie
Petricelli.

1. Find Connie Petricelli. (Go to Find, enter Petricelli in the LastName field)
and click in the record.

2. Then create a new record by clicking on the Create Record button.

3. Inthat new record, click in the Title field and go to Insert = From Last
Visited Record.

4. Tab to the Salary field and repeat, this time using the keystroke Ctrl/38 + ‘.

Select Field Entries From a List of All Previous Entries

To guarantee uniformity of data values, it is possible to select from an index of
existing values for that field. This can be used in Find mode as well.

1. Locate the cursor in the appropriate field.

2. Gotolnsert 2> Insert from Index (Ctrl/38 +1).
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RESULT: You should see a list of all the current values for that field. By clicking in the
Show individual words check box, all the field values are broken into individual words.

EmployeeID 9990005
LastName Petricelli View Index
FirstName Connie
MITAddress %56'038 Administrative Assistant
StreetAddress 17 Walnut Street Administrative Officer |
city Boston Assistant Professor !
state MA Computer Support |
2ip 05134 Consultant | !
p Consultant Il
WorkPhone %3-2582 Department Chair
HomePhone 617 584 6841 Fiscal Officer
Email cpetricelli@mit.edu Lab Tech
DateofBirth 112/1/1936 Lab Tech | s
DateHired 3/17/2009 tabTechll v

Department Electrical Engineering ... |

Title [Technician
salary $35,860.00

SalaryAvg [$35,336.67
N C oot
otes _Cancel Paste

‘mergencyContact

[ Show individual words

Re-sort values based on: | »

tionshipofContact

Contactsphone
Salaryttl [$106,010.00 |

Select the appropriate value from the list.

4. Either double click the entry to select and paste it into the current field or select and
Paste.

Exercise 5 — Review of Data Entry Techniques

1. Inthe Employee Record file create a new record for Gretchen Twitchell with the
following additional data:

MIT Bldg 24-110

8-4577

gwitchell

44 Rose Ct.

Somerville, MA 02445
617 578-4586

$38,000 salary
Administrative Officer
DOB 05/24/60

Date of Hire 07/21/1999

2. Delete Steve Sawyer’s record from the database.
3. Which shortcut could you use to repeat data that appeared in another record?

Using this short cut, add a new employee to the database who has the same job title and
salary as Craig Garelli.

4.  Which shortcut can you use to assure consistency with existing values?

Using this shortcut, add a new employee and assign her the job title of Fiscal Officer.
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Container Fields

FileMaker introduced container fields in version 7. These fields that can be used to
store files including graphics, movies, photos, bitmaps, sounds up to 4 GB in size,
multimedia file types supported by QuickTime 6, and documents, including
Microsoft Word and Excel files, PDF files.

How you place information into the container field will determine what you can do
with that information later.

You cannot search on container fields.

You can insert information into a container field in a variety of different ways. You

can

. cut and paste

. insert

. insert a link (a reference) to the file.

Be aware that Windows and Macintosh handle these processes a little differently.

Try It > Go to the Layout called Personnel Info — Tabbed and click on the Personal tab.
Navigate to Grace Baumgartner and insert her picture from the Employee Photos

folder.
1. Click in the container field.
2. Go to Insert > Picture

A navigational dialog box opens.
3. Navigate to the file you wish to insert.

Notice at the bottom of the dialog box the option to enter a link or reference to the file.

File nhame: aracebaumngartner. tiff v
Files of type: All Pictures [*.jpa;” jpea;™ ifif;".jpe;*.aif*.png;*.br +

[]store only a reference to the file

4. Click Open
5. Repeat for David Edgewater and insert his photo as a reference. Compare
the two examples.
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Sorting Records
In Browse mode, you can temporarily change the order of the records by using Sort. This
order will then be in effect for all layouts until another action such as a Find or an Unsort is
performed.

Beginning in FileMaker 10, this sort became a kind of persistent sort, that is, whenever a
record is added or changed in an already-sorted set, this new record will take its
appropriate place in the sort order.

I

&
A

1. To sort, either click on the icon in the toolbar, go to Records - Sort or
use the keystroke Ctrl/88 + S.

RESULT: The Sort Records dialog box appears. On the right hand side, you will see, if any, the
criteria of the last sort performed.

Sort Records

| Current Layout (“Salary") ?] Sort Order i

City ¢ DateHired al
DateHired Clear All

LastName -
Salary Move
‘ Title ‘

al (*) Ascending order
h. Descending order

Ia Custom order based on value list <unknown>

Reorder based on summary field

Override field's language for sort English

Unsort /_Cancel \( Sort \

2. Iffields appear in the Sort Order box, click Clear All.
3. Double click (Select and Move) the fields you wish to sort by.

RESULTS: The field(s) you selected now appear in the Sort Order box. The double -pointed
arrow alongside the field name is used to reset sort order priority.

Ascending order is assumed. To change to descending, select the field in the Sort Order box
and then click on the Descending radio button. Observe the “Custom order based on a value
list” option. Later we will discover that we can customize sort orders by defining a value list.

Observe the Unsort button.

4. Click Sort.

RESULT: The file is sorted, you are in Browse mode and the Status area reflecst this sorted
status.

Try it > Sort the records by Title in ascending order and by DateHired in descending order.
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itis reopened. (This is not true of databases on a shared server.)

Try it > Perform a sort, close the file and then reopen it.

Quick Sort

Alternatively, you can perform a sort using the right click in Windows and a Ctrl-Click on

the Mac:

1. In Browse mode, move the cursor to the field you wish to sort on.
2. Rightclick (Win) or Ctrl-click (Mac).
3. From the context-sensitive menu, choose the desired sort.

Chu

Secretary 7/18/1996 $30,140

Fayerweather

{Department Chait  FileMaker Pro Help

Papas
Edgewater
Colt
Trainor
Correia
Stein
Sawyer
Darden
Friendly
Nartoli
Jacobs

Little

100 oo ™ Browse

Administrative As 39,350
Secretary 31,678
Visiting Scholar Paste 17,960
Lab Tech Font p 13,142
Professor Size > 16,530
Consultant I %y):f Color : 12,240
Consultant Il $0,150
Tech Writer Insert g 1,580

oLy sort Ascending 1,030

Sort Descending

Computer Suppol ; 30,800
. e Sort By Value List I

Professor 19,170

Administrative s 1nd Matching Records 1 .

Constrain Found Set
Extend Found Set

Export Field Contents... E

Try it > Sort the employees in descending order for DateHired.

File Management topics
Before we leave Browse mode, there are two file management tasks we should visit:

The ability to export data from a FileMaker file and “Save a Copy As.”

Export Records...

If you wish to export data from your database, you can do so by using the command

Export Records...

1. 1. Goto File > Export Records... You will be asked to specify where you

wish to save the newly created file.
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FileMaker opens a Save dialog box, allowing you to navigate to where you wish to
save the resultant file. Often times, it will suggest a Tab-Separated Text file by
default. There are many other formats to choose from, including a FileMaker Pro

file.

Export Records to File

Bl

Save As: exporteddata.tab

Where: | (5] Desktop v

1) ¥ Tab-Separated Text

Comma-Separated Text
After saving¢ o

Merge lent
HTML Table
FileMaker Pro
XML

--v-——rrww Excel 95-2004 Workbook (.xls)
ela Professor|  E£xcel Workbook (.xIsx) Ea,sso Boston

2.  Goto Type and notice the different file types. Select the desired type.

(Cancel ) ( Save \

Notice the other options that are available. You can open this file or create an
email with the file as
an attachment. Type: | Tab-Separated Text T]
Remember to use the
operating system’s
mail program (Outlook
Express or Apple
Mail).

After saving: | Automatically open file
" Create email with file as attachment

When you specify Excel, the Excel Options dialog box opens allowing you to use
or not us the field names as column names. You can also name the Worksheet
and assign title, subject and author information to it.

3.  When you click Continue... the following dialog box opens:
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dSpeciTy rieia uraer 1or export

Select and move the fields to be exported. If you want to group data, choose the 'Group by’ fields before moving the
other fields.

Current Layout (“Salary”) 2 Group by
City (Unsorted)
DateHired
LastName
Salary
Titl .
e Field export order
¢ DateHired
¢ City
# LastName
i
Move All ¢ Title
— ¢ Salary
b Clear All
Options
Output file character set: Unicode (UTF-16)
) Apply current layout's data formatting to exported data _Cancel ) ( Export

By default, FileMaker offers to
export those fields on the current

layout. ¥ Current Layout (“Salary”)

Current Table ("Employee Records™)
To include others, pull down the

Current Layout menu and select
Current Table.

4. Select the fields to be exported. Double click to select and move.

5. Use the up-down arrow to the left of each field name in the Field export order
list to arrange the resulting columns in the desired order.

Try it --> Go to the Salary layout and export it to an Excel file, exporting only the
fields FirstName, LastName, Salary, DateHired and DateofBirth.

Save a Copy As
As discussed above, there is no Save option on the File menu, however there is Save
a Copy As.... Rather than you telling FileMaker when to save the file, it performs a
save each time a record is committed. With that in mind, you may wish to save a
copy of your database before you begin making changes to it as a backup.

One of the choices is “clone (no records).” This will create a copy of your file with all
the tables, fields, relationships,

layouts, and scripts defined but no
data. After saving:

Type:| v copy of current file
compacted copy (smaller)
clone (no records)

Try it >
1. GotoFile > Save a Copy As
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2. Name the file, and save it to the desktop.

Under file type, chose clone (no records).

4. Open the file you just created and view the results: visit File = Define =
Database ... view the Tables, Fields and Relationships tabs.

5. Visit the different layouts. Observe the absence of data but the presence of all
other constructs of the database.

w

Exercise 6 — Sorting, etc
1. Using Fast sort and the EmployeeRecords database,

e  Who was hired first?
e Who was hired last?

2. What are the two ways to enter a graphic or pdf into a container field? What
is the difference between the two?

3. Why is a sort considered persistent?

4. Create an Excel spreadsheet from the database with just the FirstName,
LastName, StreetAddress, City, State, Zip, and DateofBirth.
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Module 4: Previewing and Printing

In this module, we will

Reexamine the visual differences between Browse and Preview mode
Print a FileMaker Document
Save a FileMaker document as a PDF, as an Excel file

Compare Mac versus Windows printer settings

In Preview Mode, we see how the document will print. As we have already seen,
different objects are visible in Preview mode than in Browse. Layouts are restricted
to the margins and spacing as established by page setup and print drivers.

> Layouts for things such as labels and multicolumn reports, show a
single record or a single column in Browse mode, but all show
records with the columns appropriately wrapped in Preview mode.
(Compare the Label layout in Browse vs. Print modes.)

> Fields or objects can have “Sliding and Visibility” applied to them.
Sliding reduces space between fields; visibility allows for the hiding
of layout objects when printing.

> Variable information such as page numbers does not show up in
Browse mode but does in Preview.

When it comes time to print a document, FileMaker offers some additional options.
Going to File 2 Print, pull down the print menu and notice that you can print the

* Records being browsed (the found set),
* the current record

* or acopy of the layout without any record showing:

.‘ Print: | Records being browsed [*
Records being browsed k
Print Current record
Blank record, showing fields
MName: HP LaserJet 4100 Series PS v
Status: Toner low; 0 documents waiting
Type: HP LaserJet 4100 Series PS
Where: IP_18.152.1.208
Comment: [CJprint to file
Print range Copies
®al Number of copies: |
OPages from: | 1 to: | 1 ' ﬂ @
Mumber pages from: | 1
OLE
[[Jupdate all Links before printing
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On the Mac, go to File > Print. From the menu below Presets: choose FileMaker Pro. This
automatically opens up the dialog box to display the three radio buttons:

Print

Printer: _trng

Presets: Standard

FileMaker Pro

Number pages from: 1

Print: () Records being browsed
O Current record as formatted
@ Blank record, showing field
with underlines

Save as PDF

Saving as PDF can be performed in both Preview mode and Browse mode, sometimes with
differing results. In both places, there is the option (a pull down menu like above) to save
either the Records being browsed, Current record, or a Blank record, showing fields.

In Browse mode to save as PDF, go to File > Send/Save Record as ... > PDF.

Save as PDF

In Preview mode simply click on the button.

For more detail and further elaboration of printing, exporting and saving possibilities in
FileMaker 11, go to Lynda.com, and view Lesson 14 under FileMaker Pro 11 Essential
Training.
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Module 5: Layout Basics

”

“If the tables form the heart of a database, layouts give it a face.
Coffey & Prosser,
FileMaker Pro, The Missing Manual

In this module we will:

Define the term layout
Learn how a Standard layout is created

What is a Layout?

In FileMaker you usually have a choice of screens, each one set up to display your
data in a slightly or sometimes dramatically different way. Regardless of
appearance, all FileMaker screens are layouts which can be created, edited and even
deleted in Layout Mode. Some layouts are designed to be used as data entry screens
while others are better set up to display aggregate data in a report-like format.
Whether it is referred to as a Layout, a Report, or a Form Letter, in FileMaker, it is
still called a layout. Layouts may range from the very simple to the complex, the
latter employing an array of colors, interactive buttons, the display of web pages, the
compartmentalization of information into tabs, and other graphical tools to help
users better navigate through or to interpret data.

Data is shared in a FileMaker file by all layouts even if some layouts don’t show all
the fields stored in the file. Consider your FileMaker database a single-room
structure. The exterior windows and doors are equivalent to your layouts. If you
created a new window, you are still looking at the same contents inside the
structure. Just as when you create a new layout you are still seeing the same data in
FileMaker that you would see from another layout. If while looking at the data from
one layout you decide to change, delete or add new data, that data will change in
every other layout in the current file. How layouts display data gets to be a trickier
more complex thing when multiple tables i.e. a relational database, are at play. Even
then, the layout is the vehicle that makes it possible to view this relational data
drawn from numerous tables.

Much like a list of files, FileMaker displays a drop-down menu of layouts.

To switch from one layout to another, simply select it from the list.
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Standard
v Salary

La Hiring Report
Lo} Emergency Contact Sample

Sample Report 1
Brill Sample Report-Two Column Example
Ani Subsummary Report
Chu Labels
Fa Mail Merge Letter Sample
Pap Personnel Info - Tabbed
Ed Years of Service
Colt Phone List

In layout mode, a status toolbar across the top of the screen has icons for the various
tools that are used in creating layouts. Hover the mouse over each button to see a
tool tip explaining each button.

I - DR ETEEE G

Layout: Salary v ¥  Table: Employee Records Revert Save Layout Exit Layout

s = EED L)l &) (@) [ e v

j‘v—\hﬂhr—w—*jrrvr—"—w'—\hjFr—w—*ﬂr'v—vh'—‘?r—\r—*dr*hr—vjrv—\h'ﬂr—*r—\r—*r”?rw—v'ﬂhv—wﬂj[—;w—ﬂr"—vm—“jr—w—ﬂr*hr—'j IR s '_H—"_H_”‘”t‘:_\r_"‘

In the work area of the window you see the components of the layout. Layouts are
comprised of fields, text and graphics.

In previous versions of FileMaker, there was an Info palette that allowed you to view
and edit information about the currently-selected object. FileMaker 11 replaces this
with a three-tabbed palette which has absorbed toolbar and menu options for
Position, Appearance and Data, a kind of “one-stop shopping” for grooming and
controlling layout objects.
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The previous Info Palette: The new FileMaker 11 Inspector:
|O 0O Inspector |
0 Info 8
| Object Name: L
I ] Name
;_—' 1556] in Position 1.556 in 0.528 in
¥ 0.861] in et Top
,"’" %1251 in 1.931 in 0.75 in
=] - ‘ Right Bottom
33 1.083] in
- 2.569] in Size 0.375 in 0.222 in
I o- 22218 Width Height

——

1 | i
C |

=22 ¥ &)

‘ - l
Align Space
AEEIEEPEE
Resize
= =1 A A= =1

¥ Sliding & Visibility

Remove blank space by
[ Sliding left
[ Sliding up based on: J
(®) All objects above
(O Only objects directly above

T

("] Also resize enclosing part

R

Object visibility

Explore the many options of the Inspector. To open and close it, use the>
on the toolbar or the menu selection View = Inspector or the keystroke
&8 +1 (Mac) and Ctrl-I (Windows).

Exercise 6 — Accessing Existing Layouts
1. In Browse mode peruse the different layouts that have been created for the
database.
2. Inthe Salary layout, observe how fields are designated. Go to Labels and
compare. In Labels, you are seeing something called Merge Fields. If you have
created a mail merge in Word you may be familiar with these angle brackets.
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Compare layout mode for labels with the final product in Preview. Observe how
the label is repeated three across and as many down as there are records in the
found set and what fits on the page.

3. View the Subsummary report and notice the appearance of additional report
parts. Notice also the button in the upper right-hand corner. Double click on the
button and notice it opens a script dialog box. This is what is executed when you
click on the button. Click Cancel to close.

Exercise 7: Creating a New Layout
Layout mode is a rich environment of tools and toolbars that are familiar if you have
worked with graphics programs before, but this environment can also be
overwhelming for the person who never has.

1. To create a new layout either click the New

Layout/Report button or go to the menu Er
Layouts=> New Layout/Report, or use the
keystroke Ctrl/38 + N. New Layout / Report

RESULT: This opens the New Layout/Report dialog box:

New Layout/Report

Create a Layout/Report

Show records from: | Employee Records 8

Layout Name: Layout #9

!21 Include in layout menus .
Select a layout type: Standard form —

Table view O e

List view —

Report A S

Blank layout v

Shows one record at a time. Fields appear on separate lines. The
field label is on the left and the field data is on the right. Good for
data entry.

2 Cancel < Ba ( Next> )

» Take a minute and sample the different layout types and its resulting preview.

This dialog box is referred to as the Report/Layout Assistant because it is designed
to step you through the process of making a layout. It allows you to create a layout
in seconds, but a note of caution: Just because it is easy to create layouts should not
be cause to over indulge in the creation of new layouts, particularly when a
database is used by many people. If you need a particular layout be sure to check if
one doesn’t already exist that may serve your needs. And if you create a new one
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that renders a previous layout obsolete, don’t forget to delete the older layout. This
can be done by going to Layouts = Delete Layout.

2. Show records from: should display the name of the table that layout is
based on. In our case, that is Employee Records

Every layout has a context, that is it is based on a specific table. In our
database there is only one table, so this is not an issue now, but will become
important when there are multiple tables in a database.

Every layout should be given a unique and descriptive name. If you are a
member of a group using a database, you may wish to decide upon a naming
convention. For example a two-letter prefix on layout names would
designate the “owner” or creator of the layout.

3. We will call this layout Class Example. Click the check box for Include in

Layout menu.

We will begin by creating a simple standard layout. Choose Standard
form from the layout type list and click Next >

The New Layout/Report Specify Fields dialog box opens.

New Layout/Report

Specify Fields

Specify the fields you want on your layout. Make sure the fields are in the order you want them to appear
on your layout.

Available fields
Current Table ("Employee... T]

EmployeelD

LastName

FirstName

MITAddress

StreetAddress

City

State

Zip

WorkPhone

HomePhone

Email

DateofBirth

DateHired

Department 4
Title v

Layout fields

(" Move All )

(Cancel ) ( <Back ) (Next>)

5. Choose the fields that will be included in the report. Select the field

names in the left-hand scroll box and click Move or double click the field
name to perform a select and move.

EmployeelD
LastName
FirstName
MIT Address
StreetAddress
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City
State
Zip
Email

6. Use the small north-south arrow icon to the left of the field name to drag
the Email field before the Employeeld. You will see this character
throughout dialog boxes in FileMaker. It allows for the reordering of
elements.

e P

Specify Fields

Specify the fields you want on your layout. Make sure the fields are in the order you want them to appear

on your layout.

Available fields

[ Current Table (“Employee... q Layout fields
EmployeelD ¢ EmployeelD
LastName $+ LastName
FirstName # FirstName
MITAddress # MITAddress
StreetAddress # StreetAddress
City + City
State + State
Zip + Zip
WorkPhone 4+ Email
HomePhone
Email
DateofBirth
DateHired -

Department 4
Title v

IZI ( Cancel ) ( < Back) M

7. When all the fields are specified and in the desired order, click Next >

New Layout/Keport

Select a Theme

Themes affect the appearance of your onscreen or printed report. Select a theme to change background

color or text size, color, or style.

Layout themes

Default
Standard
Orange Mist
Breeze
Earth
Cranite
Handmade
Handwriting
Powder Puff
Sage

Sky Blue
Typewriter
Aqua screen
Agua print

< »(

ﬂ Header

Field Label

Field Text

Footer

2

("cancel ) ( <Back ) ( Finish )
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RESULT: The New Layout/Report, Select a Theme dialog box opens. These are
themes for report layouts. As it says, a theme sets background colors, text size,
text color and style.

8. Peruse the different themes that are available, viewing the previewed
sample to the right. Some themes are more appropriate for viewing on a
screen while others are for printing.

FileMaker 10 saw a refurbishing of the old themes and the creation of
new ones.

9. Choose a theme of your liking, or just go with Standard, and click Finish.

RESULT: You are in layout mode viewing the constructs of your new
layout.

10. Click on the Exit Layout button.

RESULTS: You are in Browse mode viewing your newly created layout.
The Standard layout, by default, is in form view, that is, one record per
screen. The layout contains the fields you specified. The fields are left
aligned and their respective field labels are right aligned.

11. Peruse the records of the database using this layout.

We will leave layout mode here for a while. The next FileMaker class concentrated
on the creation of layouts. Why? Why not jump right into database design?
Because an understanding of FileMaker’s reporting capabilities will better inform
your design consideration for that database solution.

For extra practice and study, visit Lynda.com’s FileMaker Pro 11 Essential Training,
modules 8: Creating Layouts, module 9: Workng with Layouts and module 10:
Formatting Layout Objects.
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Lynda.

FileMaker resources are especially plentiful for reference and self-study.

com

Lynda.com has a very broad spectrum of online course offerings, available to the
MIT community. As of January 2012, we now subscribe to what is known as Lynda
Campus. This enhanced version of Lynda creates an individual profile for each user
where a history is kept of all courses and modules taken. The student can bookmark
courses and modules of interest. A Certificate of Completion can also be received for
those courses viewed in their entirety.

Industry experts have been sought out to teach courses in Lynda.com. The lessons
for FileMaker are excellent, taught by guru Cris Ippolite of iSolutions, Inc.

To access the Lynda catalog of courses, simply open your browse to
lynda.mit.edu

and authenticate via Touchstone. In addition to the tutorials, our agreement with
Lynda.com allows us to download and use the example files. Click on the tab on the
course page to learn more.

Explore the many chapters and modules. Modules, which review the information
covered in today’s course, are the modules:

1. Getting Started

2. Database Creation Essentials

6. Working with Records

8. Creating Layouts

11. Finding Data

12. Sorting Data

14. Printing and Savings (Previewing pages and print options, Printing in
different views, Savings as a PDF or Excel file)

In preparation for the next FileMaker course, review the modules 2, 3,
7,8,9,10 and 15.

Bundled with the Software

Self-study resources come bundled with the FileMaker application. One of the first
places you may want to look is on the Quick Start screen that opens when you
launch FileMaker. If you don’t see this screen, go to Help = Quick Start Screen. It
looks like this:
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FileMaker Quick Start

Create a New Database

Create a new file, then define fields,
add records, and enter data.

\E}_' Create a New Database

Convert an Existing File

Start from an Excel, Tab Delimited,

Comma Separated, Merge, or Bento file.

Open a Database (Q]

v Recent Files

old-InventoryExample DemoOne
Inventory_three .../ITPartners2010Presentat
EmployeeRecords-FM11Relational
officeteam

OfficeTeam

EmployeeRecords-FM11

EmployeeRecords

Video Tutorials

View instructional videos, plus get
access to other helpful resources.

Visit the Resource Center »

Hands-on Tutorial

Expand your skills with
step-by-step instructions.

Startnow »

3 Convert an Existing File A Sketch
' Inventory_three .../ITPartners2010Presentat

survey_test Converted .../temp - desktopcle

Use a Starter Solution FileMaker Forum

w Favorite Files
Ask questions and receive advice
from other FileMaker Pro users.

Select a pre-designed template for
business, academic, or personal tasks. | — e

E Use a Starter Solution ( Browse... Manage Favorites

Go to the FileMaker Forum »

Close

[zshow this screen when FileMaker Pro opens

Explore the Video Tutorials and the Hands-on Tutorial. The first takes you to the
FileMaker web pages and their selection of videos. The second utilizes files that get
downloaded when you install the FileMaker software on your computer. There are
tutorials, example files, and a reference manual. Look in the folder marked English
Extras. On both Windows and the Mac, go to FileMaker 11 folder within Program
Files (Win) or Applications (Mac), and locate a folder called English Extras.
Within this folder is another called Electronic Documentation. You will find two
pdfs: The fmp11_tutorial and fmp11_users_guide.

A Definitive Text
A handy and very readable book on FileMaker is Susan Prosser and Stuart
Gripman’s FileMaker 11: The Missing Manual. Why missing? This is the book that
should’ve been in the box with the software. Itis from O’Reilly Press. O’Reilly press
books are available through Safari (not the browse, the electronic bookshelf) and
can be accessed by MIT faculty, staff, and students via the Library’s VERA, the
Virtual Electronic Resource Access.

1. Go to http://libraries.mit.edu .

2. Select E-Journals & Databases, and enter SAFARI into the search slot.

3. Click on the Safari Technical Books Online (O’Reilly Books) link that comes up.
You will arrive at a page where you can search for books by title or topic.

4. From the list of hits, select the book, navigate to the table of contents, or
search the book by key word.

TechNet
For years, FileMaker, Inc. has promoted a user community called FileMaker
Technical Network, or TechNet, charging a membership fee. As of January 2012,
membership is free! With membership, you have access to many valuable resources
such as technical briefs, how-to articles, white papers, and a community of
FileMaker users and developers and the forums they participate in. Information can
be found at
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www.filemaker.com/technet/

FileMaker Training series
FileMaker, Inc. produces the finest (of course) self-study materials available. Their
FileMaker Training series is a self-paced learning package designed for the
individual who wishes to build knowledge and skills in the design and development
of FileMaker databases. These are the training materials that will prepare one for
the FileMaker Developer’s certification exam. To obtain these materials go to the
FileMaker site: www.filemaker.com/support/training and view the FileMaker
Training Series under Self-Paced Training. The price is usually about $99, but with a
membership to TechNet, FileMaker 11 materials can be purchased at a discount.

Copyright © 2012 by MIT IS&T. 51



